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1 Welcome to the World of GUITAR RIG 4!

GUITAR RIG KONTROL EDITION is the complete solution for guitar and bass players.
The stage-ready RIG KONTROL foot pedal integrates seamlessly with the GUITAR RIG 4
software and provides studio-quality sound with its built-in audio interface. It is designed
and optimized for GUITAR RIG 4, but as it complies with industry standards and features
full MIDI support, it works perfectly with most professional audio software.

The RIG KONTROL connects to your computer via high-speed USB 2.0, which also provides
its power supply. It features two inputs, suited either for instrument or line level signals.
A two-channel line-out connects to your monitoring system, and a stereo jack allows for
headphone monitoring at an independent volume.

As a controller, the RIG KONTROL offers 9 switches and a pedal, giving you control over
almost all of GUITAR RIG 4’s functions. Moreover, it features MIDI connections as well as
two analogue inputs to connect external controllers.

In the following chapters you will learn more about the RIG KONTROL and how to make the
best use of it. Please read this manual carefully in order to get acquainted with the product.
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2 Before you Start — Important Notes

First things first; before using GUITAR RIG 4, it is advised that you read this chapter carefully.

2.1 Serial Numbers & Nameplate

GUITAR RIG KONTROL EDITION comes with two serial numbers. The RIG KONTROL
serial number can be found on the bottom of the hardware, along with the nameplate listing
the product model name and other technical information. The serial number for activating
GUITAR RIG 4 is located on the sleeve of the product CD.

2.2 Using the Unit Safely

Please read the following instructions thoroughly to prevent from health risks and
damaging the product.

2.2.1 Warning

To prevent hearing damage, always follow these important security advices:

» This Product, in combination with an amplifier, headphones or speakers, can produce
sounds in decibel ranges that may cause hearing damage.

» For protection, set all volume levels to a minimum before using the RIG KONTROL.
Gradually raise the volume controls while music is playing to set the desired
listening level.

» Do not operate it at high volume levels for long periods. If you experience any hearing
problems or ringing in the ears, consult an audiologist immediately.
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2.2.2 Caution

To make sure that the RIG KONTROL or any device connected is not damaged during
usage or maintenance, it is important that you follow these instructions:

» Do not open the device or attempt to disassemble or modify the internal parts. The
device contains no user-serviceable parts. If it appears to be malfunctioning,
discontinue use immediately and have it inspected by qualified service personnel.

v

Do not expose the unit to rain, use it near water or in damp or wet conditions.

v

Do not allow any objects or liquids of any kind to penetrate the unit.

v

Never use or store the unit in areas that are subject to temperature extremes (e.g.
direct sunlight in an enclosed vehicle or near heat-generating equipment) or high
levels of vibration.

» Do not place the RIG KONTROL in an unstable position where it is possible the unit
could accidentally fall. Remove all connected cables before moving the unit.

v

Before turning the power on or off for any component, set all volume levels to their minimum.

v

Do not use excessive force on the knobs or connectors.

» When cleaning the RIG KONTROL, use a soft, dry cloth. Never use paint thinners,
solvents, cleaning fluids or chemical-impregnated wiping cloths.

2.2.3 Disposal Notice

Should this product become damaged beyond repair, or if you wish to dispose it, please observe
the regulations of your area and country that relate to the disposal of electronic products.

2.3 Disclaimer

Native Instruments GmbH cannot be held responsible for damage or lost or destroyed data
caused by improper use or modification to the RIG KONTROL.

The information contained in this manual is believed to be correct at the time of printing
or digital release. However, Native Instruments reserves the right to make changes to the
specifications at any time without notice or obligation to update existing units.
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3 The RIG KONTROL Hardware

This section will give you an overview of the RIG KONTROL hardware.

3.1 Top Panel

< = o —= ? peoas @W'::‘.['-.'E ﬂ@m@

& Guitar Rig

5 /PREV 6 / NEXT 7/ TUNER

1 The footswitches can be assigned in the software to perform tasks such as stepping
through presets, or turning individual components on and off. Each switch has an LED
to indicate whether it is activated. The top row is labeled with the most frequently used
functions of GUITAR RIG 4, matching their pre-configured assignments.

2 The expression pedal can be used to control any continuous parameter of the
software, such as volume or wah-wah. There is an additional freely assignable switch
underneath the tip of the pedal.

3  Shows the number of the currently activated GUITAR RIG 4 preset.

4 This LED-Meter shows the level of the audio signal at the input. The red LEDs indicate
clipping and should never light up. Turn the according input gain down if it does.
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9 This LED-Meter shows the level of the audio signal at the output. The red LEDs
indicate clipping and should never light up. Turn the output level down if it does.

6 This LED indicates that the RIG KONTROL is receiving MIDI signals from a sequencer
or from another controller.

1 This LED shows whether the switch underneath the pedal is activated.

3.2 Rear Panel

1 The Inst/Line switch sets the input sensitivity for Input 1 and 2. When depressed,
the inputs will handle instrument signals such as a guitar or bass, when pressed, line
level signals are accepted. The selected input type is also indicated on the unit’s top.

2 This knob controls the gain of Input 1.

3 The socket for Input 1 (14” jack, TRS balanced) will accept line level or instrument
level signals, depending on the position of the Line/Inst switch. Connect a guitar, bass
guitar, keyboard or the left channel of a stereo device.

4 The socket for Input 2 (¥4” jack, TRS balanced) will accept line level or instrument
level signals, depending on the position of the Line/Inst switch. Connect a second
guitar, bass guitar, keyboard or the right channel of a stereo device.

9 This knob controls the gain of Input 2.

6 These jacks transmit the processed output from the audio interface. Connect both
for stereo sound.
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10
11

12

The output amplification can be set to full or —14dB.

Separately controls the volume of the headphones output.

For connecting stereo headphones.

For connecting external expression pedals, footswitches, volume pedals or switchboxes.

The RIG KONTROL features a MIDI interface with 1 input and 1 output. The RIG
KONTROL does not require MIDI to send controller messages to GUITAR RIG 4, but
it is able to send MIDI signals to other applications.

The USB port connects the unit to your computer. Your computer must support USB
2.0 in order to work with GUITAR RIG SESSION 1/0. The unit also relies on the USB
bus power to function. Connect this unit directly to your computer’s USB 2.0 port
and avoid using un-powered USB hubs. You should always secure the USB cable by
wrapping it around the USB Hook.
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4 Installation under Windows XP / Windows Vista

This chapter describes the installation of the RIG KONTROL hardware under Windows
XP and Windows Vista, focusing on the setup of the audio interface. To activate the foot
pedal as a controller in GUITAR RIG 4 and to use its MIDI capabilities, please refer to
section 6 of this manual.

For detailed information about the GUITAR RIG 4 software, please consult the Application
Reference. You can find this on the product CD or in the GUITAR RIG 4 menu under Help
> Open Manual > Your Language.

4.1 Software Installation

Make sure you are logged in with administrator privileges. Don’'t connect the RIG KONTROL yet.

1. Browse the content of the product CD and locate the setup file. It is called “Guitar Rig
4 Setup”. If you are using a download version of GUITAR RIG 4, you need to extract
the setup files first.

2. Double-click “Guitar Rig 4 Setup” to start the installation procedure.

Ou Native Instruments Guitar Rig 4 - Installiware Wizard g|§||z|

Welcome to the Native Instruments
Guitar Rig 4 Setup

Mote: After installation, do not move or rename the application
or the installation directory of the application, Otherwise, wou wil
not be able to run update installers,

Please make sure that the Guitar Rig 4 hardware is
not connected during this installation!

To continue, click Mext,

Mesxk = l [ Zancel
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3. Follow the on-screen instructions, which will guide you through the installation procedure.

4. You will be asked to specify the path to the plug-in folder of your DAW (Digital Audio
Workstation, e.g. your sequencer software). If you will use GUITAR RIG 4 exclusively in
standalone mode, or if you don’'t know what a plug-in is, just use the standard setting.

9. You will be asked if you want to install drivers for the GUITAR RIG audio interfaces.
Select “RIG KONTROL" and click on “Continue”.

6. During installation of the driver, several Windows security messages will
show up, e.g. “The driver has not passed the Windows Logo Test” or
“Windows can’t verify the publisher of this driver software”. Don't worry,
everything is fine here. Simply click “Continue anyway” (Windows XP) or “Install
this driver software anyway” (Windows Vista) to continue the installation.

Software Installation

L] 'I_., The saftware you are installing has not passed Windows Logo
5 testing ta wverfy its compatibilty with Windows XP . (Tell me why
this testing is important.)

Continuing your installation of this software may impair
or destabilize the comect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the software vendor for software that has
passed Windows Logo testing.

[ Cortinue Amyway ] l STOP Installation

1. Restart your computer upon completion.
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The following applications have been placed onto your hard drive:
» GUITAR RIG 4 — the fully featured standalone application.

» GUITAR RIG 4 plug-ins — Use GUITAR RIG 4 as a plug-in for your Digital Audio
Workstation (DAW) of choice. On Windows computers, GUITAR RIG 4 supports the
VST and RTAS® plug-in formats.

» Native Instruments Service Center — this application handles product activation as well
as update management. Please refer to the Setup Guide for details.

» The drivers for the RIG KONTROL.

In case you want to install the hardware drivers only, a separate driver installer file is
available on the installation CD. You can also download its latest version from the Support
section of the Native Instruments website.

4.2 Hardware Installation

Use the supplied USB cable to connect the RIG KONTROL directly to a USB 2.0 port on
your computer.

OUTPUT PHONES
t—L & monow T
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The RIG KONTROL is powered via USB. Operation is guaranteed only with a USB 2.0
controller as a single device or with self-powered USB 2.0 hubs. On Windows XP systems,
Service Pack 2 or higher is required for the RIG KONTROL to work — you can find out

about your Windows version in the System Properties window.

System Properties

System Restore
General

q

Automatic Updates Remote
Computer Name Hardware Advanced

System:
Microgoft Windows XP
Professional

'l j Version 2002

Service Pack 3

Registersd to:

J

76487-0EM-D011503-00102

Dell Latitude D630

Intel(R) Care{TM)2 Dua CPU
T3300 @& 2.50GH:z

249 GHz, 1.99 GB of RAM
Physical Address Bxtension

[ Support Information ]

I OK ][ Cancel ]

After successfully installing the driver, the RIG KONTROL will be recognized automatically.

If not, start the software installation again as explained above.
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Several driver modules will be assigned to the RIG KONTROL now, each one causing a
pop-up window in which you are asked how you want to install the new device.

1. Choose not to connect to the “Windows Update Web site”.

2. Choose “Install the software automatically” (Windows XP) or “Locate and install driver
software” (Windows Vista).

Found New Hardware Wizard

This wizard helps you install software for:

GuitarRig Mabile /0

\-\,I if your hardware came with an installation CD
—i? or floppy disk. insert it now.

What do vou want the wizard to do?

(®) Install the software automatically (Recommended)
() Install from a list or specific location {Advanced)

Click Mext to continue.

[ < Back ][ Mext = ][ Cancel ]

3. Follow the on-screen instructions to complete the procedure.

4. The Windows security warnings will appear. Please ignore them and click “Continue
anyway” (Windows XP) or “Install this driver software anyway” (Windows Vista) to
properly install the drivers.

On a Windows computer, the driver is associated with a particular USB port. If you plug
the USB cable into a different port than the one it was installed at, the driver assignment
process starts again — if this happens, just follow the steps described above.

If at any time the computer does not seem to recognize the RIG KONTROL, disconnect
the USB cable, wait a few seconds, then re-connect it. If the problem remains, restart
your computer with the interface connected.

GUITAR RIG KONTROL Hardware Reference — 17



4.3 Configuration

This chapter explains how to use the RIG KONTROL audio interface with Windows XP /
Windows Vista and particularly with GUITAR RIG 4. It is assumed that you have already
activated GUITAR RIG 4 using the Service Center — please refer to the Setup Guide for
help on this process.

4.3.1 Configuring GUITAR RIG 4

We will now set up GUITAR RIG 4 to use the RIG KONTROL audio interface. Start the
software before you proceed.

When the software is started for the first time, you will be prompted with the Audio Setup
window automatically, where you need to make the following settings. To access these
settings later on, select File > Audio and MIDI Settings from the program menu.

-
Audio and MIDI Settings. ..

Audio Routing MIDI )

Driver [ AsiO -]
Device [ AsI0 Config | [ Rig Kontrol 3 -]
Status Running

Sample Rate (44100 -]
Latency 88 Samples

Input» 2.5 ms | Processing » 2.0ms | Output » 4.5 ms | Overall » 9.0 ms

| © Cancel | | @ 0K |

1. On the “Audio” tab, choose ASIO as the “Driver” interface.
2. Select RIG KONTROL from the “Device” dropdown menu.

If RIG KONTROL does not appear in the list, something went wrong. Restart the
installation as explained in section 4.1.
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You can access the Driver Control Panel by clicking on “ASIO Config”. In the Driver Control
Panel, two status fields on the bottom show whether the RIG KONTROL hardware is
connected and ready to use.

Ot MNative Instruments Rig Kontrol 3 Control P... EJ|E|E|

Soundcard Latency Settings

Frezats: |n'|ir'|imal latency (low CPU usage situation) j

Thiz zetting offers a minimum output latency of =6 mz [9 me input o
output] but zhould only be uzed in stuations with low CPU uzage.

USE Buffersize: | | Audio Bufferzize: | |

Buffer Faormnat

Sample Rate: | 44100 Hz "|
A bt |

Feady connecked

The audio interface allows to be configured by the following parameters:

» PreseTs: Several presets for common types of usage are included, from minimal
latency suitable for fast systems with strong CPU power, to higher latencies suitable
for slower systems. If you are experienced in setting up audio drivers and want to
create your own custom settings, select User Defined Settings (see next).

» USB Burrersize AND Aubio Burrersize: These parameters are grayed out, unless you have
selected User Defined Settings from the Presets Menu. Together, they define the
system’s latency, i.e. the time that passes from the moment an audio signal is sent
into the RIG KONTROL hardware until the moment you hear it in your headphones or
your speakers. The value for Audio Buffersize must always be at least twice as large
as the USB Buffersize value. Note that the USB Buffersize parameter has a direct
iImpact on the CPU usage of the system. The resulting CPU usage differs between
computers, so it could make sense to experiment with different settings.
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» SampLE RATE: Choose a sample rate that is compatible with your music application and

suited to your computing power. Per default, the sample rate is set to 44100 Hz
(CD-Quality). Higher sample rates may improve sound quality, but will cause a higher
CPU load as well.

It is recommended that you try the latency presets first and then continue with the
subsequent steps of the installation. Once you are finished, you should revisit the Audio
and MIDI Settings to figure out the best latency setting for your system. If audio dropouts
occur with the preset minimal latency, you can try the low latency or standard latency set-
tings instead. Higher latency values will reduce the probability of audio dropouts.

4.3.2 Using the RIG KONTROL as your Default Audio Interface

If you want to use the RIG KONTROL for playback of all audio applications on your
computer (not only for music software), you have to set it as your default audio interface.

For Windows XP, this works as follows:

1.
2.
3.

Open Start > Control Panel > Sounds and Audio Devices.
Select the “Audio” tab.

In the “Sound playback” and “Sound recording” sections, click on the Default Device
menu, and then select RIG KONTROL.

Click OK to close the “Sounds and Audio Devices” dialog.
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Sounds and Audio Devices Properties

YWolume Sounds Audio Woice Hardware

Sound playback
Default device:
2/

Rig F.ontral 3 Output w

Vaolume... ] [ Advanced. .

Sound recording
ﬁ Default device:
Rig F.ontral 3 Tnput w

MIDI music playback

% Default device:

222 | Microsoft GS Wavetable SW Syrith W

[ Volume... ] [ About...

[] Use only defautt devices

| ok || cancel || Aoy

]

For Windows Vista, this works as follows:

Open Start > Control Panel > Hardware and Sound > Sound.

Select the “Playback” tab.

In the device list, select RIG KONTROL and click on “Set Default.”

In the device list, select RIG KONTROL and click on “Set Default.”

1
2
3
4. Select the “Recording” tab.
9
b

Click Ok to close the dialog.
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4.4 Audio Connections and Levels

In the following chapters you will learn how to connect your guitar and your monitoring
system to the RIG KONTROL and how to set the right amplification levels both on the
hardware and on the software side of your setup.

Please start GUITAR RIG 4 before proceeding.

4.4.1 Connecting your Instrument and Adjusting the Input Level
1. Turn down the volume on your monitoring system to prevent hearing damages.

2. Make sure the input selector is set to “Instrument” (button not depressed) except if
you are using a preamp to boost your signal to line level.

3. Plug the cable connected to your guitar or bass into one of the input jacks of the
RIG KONTROL.

4. Completely turn down the volume of the input channel you are not using.

Keep in mind that for an instrument that generates a stereo signal, such as a synthesizer
keyboard, you need to connect it to both input channels for stereo sound.

—

In order to achieve the best sound quality by providing the interface with a sufficiently
powerful signal, you need to carefully adjust the input level of the RIG KONTROL.
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The Input Level Meter helps you identify the level of the incoming signal:

Meter Status Meaning

All LEDs are off No incoming signal

Green LEDs flashing Incoming signal

Green and red LEDs flashing Incoming signal is too loud

Before adjusting the input sensitivity, turn up the volume knob on your guitar. Strum some
chords at the volume level you are typically playing at and look at the Input Level Meter:

1. Turn up the input level knob next to the input jack you chose, just until the meter
Is reaching the red zone when you play.

2. At that point, slightly turn the knob down until you are safely in the green zone, even
when you are playing really powerful chords.

Now the input sensitivity is set to its optimum level, enabling the RIG KONTROL to provide
the highest dynamical range without clipping.

4.4.2 Connecting a Second Instrument

You can connect different instruments to both input channels, as long as they both provide
a signal at the same level (line or instrument). Just plug the cable of your second instrument
into the other input jack and set the right input level as described in the previous section.

For instruments generating a stereo signal, the second channel needs to be connected
for stereo sound.

If only one channel is used, set
the other channel’s Gain knob
to zero.
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4.4.3 The Input Level of GUITAR RIG 4

It is assumed that your guitar is connected to the RIG KONTROL and its input level is
properly adjusted (see section 4.4.1). Now you need to make sure that the input signal
Is processed at the right level by the software.

Please take a look at the header of the GUITAR RIG 4 window: It consists of the input
module with channel selectors (L/R), a basic noise gate, the output module with a limiter
and information about the processing power consumed.

Note that the Input Meter shows an amplitude when you are playing. It also features an
integrated volume fader that controls the input level of the software. Please adjust it to
achieve the highest possible level for your signal without clipping. This is indicated by the
Level Meter getting close to the red zone without actually hitting it.

If only one guitar is connected, GUITAR RIG 4 will receive a mono signal. You can set up
the Input module to route your guitar signal to both channels. Per default, GUITAR RIG 4
Is set to process both input channels (L + R are activated), so one of the input
channels remains mute. To change this, deactivate the channel you are not using: Click on the
appropriate button (L or R) on the left hand side of the Input Meter once, so that only the
input channel in use is active. This will route the mono signal to both channels.
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4.4.4 Connecting the Output

The RIG KONTROL provides two mono outputs (L/R) to connect your monitoring system,
be it a mixing desk, a pair of active speakers or your home stereo. Mind that both of
them have to be connected for stereo sound. A separate stereo output (TRS) allows for
connecting your headphones.

-

PHONES PEDAL  MIDI er

R HIGH/LOW ,—‘— O 1—L—2 UsB 2.0

-

1. Connect the output jacks to the input of your amp with its volume level turned down.

2. If you are using headphones, connect them to the output jack and put them on with
the headphone level fully turned down.

3. Go to the Preset Browser and select one of the presets by clicking on it.

4. Start playing and carefully turn up the volume of your amp or the headphone level of
the RIG KONTROL to the desired level.

You should be all set now, and ready to rock!
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5 Installation under Mac 0S X

This chapter describes the basic installation of the RIG KONTROL hardware under Mac OS
X, focusing on the setup of the audio interface. To activate the foot pedal as a controller
in GUITAR RIG 4 and to use its MIDI capabilities, please refer to section 6 of this manual.

For detailed information about the GUITAR RIG 4 software, please consult the Application
Reference. You can find it on the product CD or in the GUITAR RIG 4 menu under Help
> Open Manual > Your Language.

5.1 Software Installation

Make sure you are logged in with administrator privileges. Don’t connect the RIG KONTROL yet.

1. Browse the content of the product CD and locate the file “Guitar Rig 4 Installer”. If
you are using a download version of GUITAR RIG 4, you need to extract the installer

file first.
2. Double-click the installer file to start the installation procedure.
800 « Install Guitar Rig 4

Welcome to the Guitar Rig 4 Installer

& Introduction

MNote: After installation, do not move or rename the
application or the installation directory of the
application. Otherwise, you will not be able to run
update installers.

(NI}

H
. Continue v
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3. Follow the on-screen instructions that will guide you through the installation procedure.

4. You will be asked if you want to install drivers for the GUITAR RIG audio interfaces.
Select “RIG KONTROL” and click on “Continue”.

3. Restart your computer upon completion.

The following applications will be placed onto your hard drive:
» GUITAR RIG 4 - the fully featured standalone application.

» GUITAR RIG 4 plug-ins — use GUITAR RIG 4 as a plug-in for your digital audio
workstation (DAW) of choice. On computers running Mac OS X, the VST, AU and
RTAS® plug-in formats are supported.

» Native Instruments Service Center — this application handles product activation as well
as update management. Please refer to the Setup Guide for details.

» The drivers for the RIG KONTROL audio interface.

In case you want to install the hardware drivers only, a separate driver installer file is
available on the installation CD. You can also download its latest version from the Support
section of the Native Instruments website.3

If you have never owned a
NATIVE INSTRUMENTS prod-
uct, you will need to register by following
the on-screen instructions. More infor-
mation about creating a NI User Account
and about activating GUITAR RIG XE is
available in the Service Center Quick
Start Guide and manual located in the
Service Center installation folder.
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9.2 Hardware Installation

Use the supplied USB cable to connect the RIG KONTROL directly to a USB 2.0 port
on your computer.

PHONES PEDAL w MIDI
—

|—'—h"ﬂ

The RIG KONTROL is powered via USB. Operation is guaranteed only with a USB 2.0
controller as a single device or with self-powered USB 2.0 hubs.

After successfully installing the driver, the RIG KONTROL should be recognized
automatically. If at any time the computer does not seem to recognize the RIG KONTROL,
disconnect the USB cable, wait a few seconds, then re-connect it. If this does not solve
the problem, restart your computer with the interface connected.

9.3 Configuration

This chapter explains how to use the RIG KONTROL audio interface under Mac OS X and par-
ticularly with the included GUITAR RIG 4. It is assumed that you have already activated GUITAR
RIG 4 using the Service Center — please refer to the Setup Guide for help on this process.
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9.3.1 Configuring GUITAR RIG 4
We will now set up GUITAR RIG 4 to use the RIG KONTROL audio interface. Start
the software before you proceed.

1. When the software is started for the first time, you will be prompted with the Audio
Setup window automatically, where you need to make the following settings. If you want
to access these settings later, select Guitar Rig 4 > Preferences from the program menu.

...

Audio and MIDI Settings...

Audio ‘ Routing MIDI
Driver  CoreAudio
Device [ RigKontrol3 (2 In, 2 Out)
Status
Sample Rate (44100
Latency 512 Samples [
Input » 16.0 ms | Processing » 11.6 ms | Output » 5.8 ms | Overall » 33.4 ms

|: © Cancel :| |: @ OK :|

2. On the Audio tab, choose CoreAudio as the “Driver” interface.
3. Select RIG KONTROL from the “Device” dropdown menu.

If RIG KONTROL does not appear in the list even though it is connected, something went

wrong. Restart the installation as explained in section 5.1.
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The audio interface allows to be configured by the following parameters:

» SawvrLE RATE: Choose a sample rate that is compatible with your music application and
suited to your computing power. Per default, the sample rate is set to 44100 Hz
(CD-Quality). Higher sample rates may improve sound quality, but cause a higher CPU
load as well.

» Latency: Use the Latency slider to set the buffer size of the audio interface, measured
iIn samples. The buffer size has two effects: The higher it is set, the lower is the
probability of dropouts during real-time audio processing. On the other hand, the size
of the buffer directly affects the overall latency of your system. The time between the
moment you hit a note and the moment you hear the processed sound will be longer
If the buffer size is increased.

It is recommended that you start with the default buffer size and continue with the
subsequent steps of the installation. Once you are finished, you should load a clean
preset and revisit the Audio and MIDI Settings to figure out the best latency setting for your
system. This is done by gradually reducing the buffer size: Drag the latency slider to the
left while playing something. Once you begin to hear crackles or dropouts, carefully drag
the latency slider to the right until you reach the point where no crackles or dropouts occur.
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9.3.2 Using RIG KONTROL as your Default Audio Interface

If you want to use the RIG KONTROL for all audio playback (not only for music software),
you have to set it as your default audio interface. For Mac OS X, this works as follows:

1.
2.

From the Apple menu, select System Preferences.
In the panel that opens, click on “Sound”.

800 Sound

[l ) Chowai] CE—

[ Sound Effects | Output  Input |

Choose an alert sound

Name Type

Basso Built-in
Blow Built-in m
Bottle Built-in
Frog Built-in
Play alerts and sound effects through: ( RigKontrol3 %q
Alert volume: of = 4)))
1 1 1 1 1

M Play user interface sound effects

EPlayr feedback when volume is changed

)

E Play Front Row sound effects

Output volume: ) ) Mute
p * 1 1 V 1 1 1 * )) E

EShow volume in menu bar

On the Sound Effects tab, select RIG KONTROL in the “Play alerts and sound effects

through” menu.

Click on the Output tab, and then select RIG KONTROL from the “Choose a device

for sound output” list.

Click on the Input tab, and then select RIG KONTROL from the “Choose a device

for sound input” list.
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9.4 Audio Connections and Levels

In the following chapters you will learn how to connect your guitar and your monitoring
system to the RIG KONTROL and how to set the right amplification levels both on the
hardware and on the software side of your setup.

Please start GUITAR RIG 4 before you proceed.

9.4.1 Connecting your Instrument and Adjusting the Input Level
1. Turn down the volume on your monitoring system to prevent hearing damages.

2. Make sure the input selector is set to “Instrument” (button not depressed) except if
you are using a preamp to boost your signal to line level.

3. Plug the cable connected to your guitar or bass into one of the input jacks of the
RIG KONTROL.

4. Completely turn down the volume of the input channel you are not using.

Keep in mind that for an instrument that generates a stereo signal, such as a synthesizer
keyboard, you need to connect it to both input channels for stereo sound.

—

In order to achieve the best sound quality by providing the interface with a sufficiently
powerful signal, you need to carefully adjust the input level of the RIG KONTROL.
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The Input Level Meter helps identifying the level of the incoming signal:

LED Status Meaning

All LEDs are off No incoming signal

Green LEDs flashing Incoming signal

Green and red LEDs flashing Incoming signal is too loud

Before adjusting the input sensitivity, turn up the volume knob on your guitar. Strum some
chords at the volume level you are typically playing at and look at the Input Level Meter:

1. Turn up the input level knob next to the input jack you chose, just until the meter is
reaching the red zone when you play.

2. At that point, slightly turn the knob down until you are safely in the green zone, even
when you are playing really powerful chords.

Now the input sensitivity is set to its optimum level, enabling the RIG KONTROL to provide
the highest dynamical range without clipping.

9.4.2 Connecting a Second Instrument

You can connect different instruments to both input channels, as long as they both provide
a signal at the same level (line or instrument). Just plug the cable of your second instrument
into the other input jack and set the right input level as described in the previous section.

For instruments generating a stereo signal, the second channel needs to be connected
for stereo sound.

If only one channel is used, set
the other channel’s GaiNn knob
to zero.
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9.4.3 The Input Level of GUITAR RIG 4

It is assumed that your guitar is connected to the RIG KONTROL and its input level is
properly adjusted (see section 4.4.1). Now we need to make sure that the input signal
Is processed at the right level by the software.

Please take a look at the header of the GUITAR RIG 4 window: It consists of the input
module with channel selectors (L/R), a basic noise gate, the output module with a limiter
and information about the processing power consumed.

Note that the Input Meter shows an amplitude when you play. It also features an integrated
volume fader that controls the input level of the software. Please adjust it to achieve the
highest possible level for your signal without clipping. This is indicated by the Level Meter
getting close to the red zone without actually hitting it.

If only one guitar is connected, GUITAR RIG 4 will receive a mono signal. You can set up
the Input module to route your guitar signal to both channels. Per default, GUITAR RIG 4
Is set to process both input channels (L + R are activated), so one of the input
channels remains mute. To change this, deactivate the channel you are not using: Click on the
appropriate button (L or R) on the left hand side of the Input Meter once, so that only the
input channel in use is active. This will route the mono signal to both channels.
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9.4.4 Connecting the Output

The RIG KONTROL provides two mono outputs (L/R) to connect your monitoring system,
be it a mixing desk, a pair of active speakers or your home stereo. Mind that both of
them have to be connected for stereo sound. A separate stereo output (TRS) allows for
connecting your headphones.

OUTPUT PHONES PEDAL
R HIGH/LOW 2

——o 1——

1. Connect the output jacks to the input of your amp with its volume level completely
turned down.

2. If you are using headphones, connect them to the Phones output jack and put them
on with the headphone level fully turned down.

3. Go to the Preset Browser and select any of the presets by clicking on it. Start
playing and carefully turn up the volume of your amp or the headphone level of the
RIG KONTROL to the desired level.

You should be all set now, and ready to rock!
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6 Using the RIG KONTROL as a Controller Interface

The RIG KONTROL enhances your experience using GUITAR RIG 4 by integrating perfectly as
a hardware controller. Aside from the built-in controller features, it offers MIDI connections
and two jacks for external footswitches and pedals. The following sections explain how to set
up the hardware to fully exploit these features. To learn how to assign functions of GUITAR
RIG 4 to controller inputs, refer to the Getting Started Guide and the Application Reference.

To use the RIG KONTROL as a standard MIDI controller, you have to use the included
CONTROLLER EDITOR software. Please refer to the Controller Editor Manual for details.

6.1 Activating the RIG KONTROL in GUITAR RIG 4

The RIG KONTROL is activated automatically in GUITAR RIG 4 when the hardware is
connected. The first time it is activated, a window will pop up asking you to calibrate the
foot pedal. Please press the pedal all the way up and down and confirm by clicking on
OK. To recalibrate the pedal at any time, go to the OpTions page and select PREFERENCES.
Click on the Reset button next to “RIG KONTROL Pedal Calibration”.

The RIG KONTROL hardware has a graphical counterpart in GUITAR RIG 4 which is shown
after clicking on the VirRTuaL KonTroL button above the rack.

If you are running multiple instances of GUITAR RIG 4 (e.g. in a sequencer), you may want
to define which of them is controlled by the foot pedal. By default, the RIG KONTROL is
activated in the instance of GUITAR RIG 4 you launched first. By clicking on the ConnEecT
button on the VirRTuAL KonTROL In another instance, it gets the focus of the RIG KONTROL
— only one instance can have it at a time!

Some functions are assigned to the footswitches 5-8 by default, as indicated by text
labels on the hardware. You can instantly step through the presets currently visible in the
browser with switches 5 (PREV) and 6 (NEXT). Switches 7 and 8 are for activating the
tuner and tapping in a tempo with your foot. These buttons can of course be re-assigned
to other functions as you please.
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The easiest way to assign a button or the pedal of the RIG KONTROL to any function in
the rack is to drag it from the VirTuaL KonTroL and drop it on the parameter you want to
control. For a detailed description of the way controller assighments work, please refer to
the Getting Started Guide and the Application Reference.

6.2 Using MIDI Controllers with the RIG KONTROL MIDI Interface

While being capable of sending MIDI messages to control other applications, the RIG
KONTROL communicates with GUITAR RIG 4 directly via USB. Nonetheless, it features a
standard MIDI interface with one input and output channel.

To use a controller connected to the MIDI input jack, make sure that the RIG KONTROL
MIDI channel is activated in GUITAR RIG 4

1. Open the “Audio and MIDI Settings”. On Windows, they are found in the “File” menu,
under Mac OS in the “Guitar Rig 4” menu.

2. Go to the MIDI tab.

3. On the “Inputs” table, locate “RIG KONTROL" and switch it on by clicking in
the “Status” column.

The MIDI input channel is set on the OpTions pane of GUITAR RIG 4: On the CONTROLLERS
tab, click on the dropdown menu labeled “MIDI channel” and select 1-16 or omni. To learn
how to assign functions to external MIDI controllers, refer to the Getting Started Guide
and the Application Reference.
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6.3 Using Additional Footswitches and Pedals

The RIG KONTROL features two jacks for connecting external footswitches and pedals with a
V4" patch cable. Once connected and set up, they can be assigned just like MIDI controllers in
GUITAR RIG 4. Refer to the Getting Started Guide and the Application Reference to see how.

Under Prererences on the OpTions page of GUITAR RIG 4, the following settings are available:

» To calibrate an external pedal, click on the Reset button next to “RIG KONTROL Ext
Pedals Calibration.”

» The two lines “RIG KONTROL Ext Pedal 1/2 Mode” allow to configure each both
inputs to match your external footswitch or pedal. Consult the manufacturer’s product
specifications to find out if it is a tip or ring active pedal, or respectively, if it is an
opening or a closing switch. If problems occur, try out the other available modes.

» The “External Switch Mode” determines the behavior of external footswitches. Either
they are “on” while pressed (Toggle) or they switch between “on” and “off” each time
they are pressed (Switch).
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1 Troubleshooting

Should you encounter any problems with your hardware, it is recommended that you
follow these steps to find a solution to your problem before contacting Technical Support:

» Visit NI's online Knowledgebase. The easiest way to find it is by selecting Help >
Knowledgebase from the GUITAR RIG 4 menu.

» Visit the NI User Forum on our website (native-instruments.com/forum/) and perform
a search for helpful answers from the GUITAR RIG user community.

When contacting Technical Support, please make sure to have all relevant information
about your computer at hand. For information about the driver’s version and the firmware
revision, please check the Driver Control Panel.

» On Windows computers you can find driver and firmware version in the GUITAR RIG 4
application folder in the Start menu. Click on “About” to display the information desired.

» On Mac OS X computers, you can access the Driver Control Panel from the system
preferences. The information is shown in the main window.

Please visit this URL to contact the support team:
native-instruments.com/support/

All products by Native Instruments are tested extensively in real life situations during the
development phase. However, if your product needs to be returned, the Technical Support
team will assign you an RA (Return Authorization) number to expedite the processing
of your return. Please contact our Technical Support team prior to returning any item.
Packages returned without this RA number will not be correctly identified and as such
might not be processed efficiently.

GUITAR RIG KONTROL Hardware Reference — 39


http://www.native-instruments.com/forum/
http:///www.native-instruments.com/support/

1.1 Audio Issues

This section provides help with the most common audio issues you may encounter.

1.1.1  No Sound or Low Volume
There are several possible reasons for a silent or low audio output:
» Disconnected or broken cables. Please check all connections and cables.

» Incorrect soundcard or audio input selected. Please check the Audio and MIDI Settings
in the GUITAR RIG 4 menu if the RIG KONTROL driver is selected.

» Wrong channel selected in the Input Module of GUITAR RIG 4. Either connect your
Instrument to the other input jack or switch to the other channel by choosing “L”
in the INPUT Module.

» The RIG KONTROL's input gain is set too low. Turn up the according Input Level.

» Your instrument’s volume is turned down. Turn up the volume knob.

1.1.2 Distorted Signal

If the audio signal sounds distorted, and no distortion is being added by the GUITAR
RIG 4 software, then this is most likely caused by the RIG KONTROL's gain being set
too high. Reduce the Input Level at the Interface to prevent the preamp from clipping.
If your instrument delivers such a high signal that the preamp is always overdriven, you
should reduce its volume. Usually, this only happens if the instrument is equipped with
special high power pickups.
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11.3 Noise

Audible hum can have several reasons, some of which are listed below:

» Single-coil pickups are prone to collecting electrical interferences. Humbucker pickups
produce much less hum, which is why they got their name.

» Your guitar is too close to electrical equipment. To reduce this type of hum, move the
guitar further away from the equipment.

» The guitar’s volume knob is set to a low level. Turn the knob up. If your guitar has
more than one volume knob, make sure to check all knobs.

» You are using a non-shielded or broken guitar cable. Your guitar’s shielding may also be
insufficient. Try replacing the cable with a shielded model first. If this does not help, you
should consider having your guitar’s electronics serviced and shielded by a professional.

If you are experiencing hiss, the input level at the RIG KONTROL preamp might be too
low. Turn up the instrument’s volume or increase the input level on the RIG KONTROL.
For more information on setting the input level, see section 4.4 (Windows XP/ Windows
Vista) or section 5.4 (Mac OS X) of this manual.

1.1.4 Ground Loops

Ground loops (usually perceived as a hum or buzz) are a common problem when multiple
electrical devices are connected to the same power circuit. The following steps should
help to eliminate them:

» Disconnect all devices that you are not currently using, e.g. peripheral devices you
may have connected to your computer (external data storage, CD burners).

» Hook up a DI box behind the RIG KONTROL outputs. Most of these boxes have a
ground lift switch, which allows breaking the ground loop and eliminating the noise.
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1.2 Hardware-Related Problems

Check the Native Instruments website and the NI Service Center for updates of the
RIG KONTROL driver and more information.

1.2.1 Driver Issues

Make sure that the RIG KONTROL is connected to the computer and open the Driver
Control Panel. See the intro to this chapter on how to find the Control Panel.

If the Control Panel is missing, the driver is most likely not installed at all. In this case,
please re-install the driver as described above.

If all the drop-down menus of the Control Panel are grayed out, the RIG KONTROL is not
recognized by the driver. Something might be wrong with the USB connection, see the
following sections for details.

1.2.2 USB Issues

The RIG KONTROL is a USB 2.0 interface and will not work on a USB 1.0/1.1 port.
Always connect it directly to a USB 2.0 port on your computer. The port needs to fulfill the
minimum power specification for a USB 2.0 port (500 mA). On certain computers, the
USB 2.0 ports do not meet the official USB 2.0 power specification. In this case, you may
see a message, saying that there is not enough power available to operate your device.
The RIG KONTROL may produce crackles or may not work at all.

» If your computer is unable to supply the necessary amount of bus power, try
connecting your RIG KONTROL to a USB 2.0 hub with external power-supply. Avoid
connecting other devices to the hub, as every bus-powered device will diminish the
total amount of power available.

» In case of failures, it is useful to check if RIG KONTROL works if you disconnect any
other USB device from the computer.

» |If you are experiencing audio dropouts or other problems that may be related to the
USB connection, try connecting the RIG KONTROL to another USB 2.0 port.
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» A bad USB cable can be responsible for audio dropouts and/or other connectivity
problems. Try using a different cable bearing the official USB logo, in some cases
using a shorter cable might help.

» |f you are experiencing problems with RIG KONTROL crashing or performing badly on
a Windows machine, the first thing to do is to disable power management for the USB
hubs, which is turned on by default. Go to the Device Manager (Control Panel > System
> Hardware) and right click a USB hub to bring up its properties. On the Power
Management page, uncheck all boxes. Repeat for each hub and reboot.

1.2.3 Using the RIG KONTROL with a Laptop

Please check if your computer is suited for handling real-time audio processing without
dropouts. There are a couple of freeware tools to analyze your system, for example:

www.thesycon.de/deu/latency_check.shtml

Start the tool with the RIG KONTROL disconnected. In case your computer is unable to
handle glitch-free audio processing, the tool will show red latency bars and report this in
the box on the bottom.

In general, it is not recommended to use laptops with shared-memory graphic cards. You
will need all the memory and processing power available for your audio project.

There are some steps to optimize your laptop’s audio performance:

» |t is not recommended to run the laptop on battery, as power management might slow
the clock rate of the CPU down, to save battery.

» Disconnect all unused hardware (e.g. printer, scanner). This will increase the amount
of processing power available for your music software.

» Laptops often are equipped with built-in devices that disturb audio processing, most
commonly a network adapter or a wireless LAN card. You might need to disable these
devices while working with the RIG KONTROL.
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8 Technical Specifications

This section contains all relevant technical specifications of the RIG KONTROL hardware.

8.1 Jacks and Sockets

» 2 input jacks (In 1, In 2) for mono 6.3mm (1/4 inch) phone plugs

» 2 output jacks (Out 1, Out 2) for 6.3mm (1/4 inch) mono (unbalanced) or TRS
(balanced) phone plugs

1 Headphones jack for stereo 6.3mm (1/4 inch) phone plug

2 input jacks for external pedals / footswitches / switchboxes
(Pedal 1, Pedal 2) for stereo 6.3mm (1/4 inch) phone plugs

2 MIDI (In/Out) 5-pin DIN circular connector

1 USB 2.0 Type B

vVvyvyyvyy
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8.2 Audio Specifications

Audio Inputs (A/D)

Channels 2

Sample Rate 44.1, 48, 88.2, 96, 192kHz
Bit Resolution 16, 24 Bit

Converter Cirrus Logic

Instrument Inputs

Input Impedance 1M Ohm

Full Scale Level at Maximum Gain -11,5 dBu

Maximum Input Level +16dBu

SNR (weighted) >100dB

THD+N 0,009%

Frequency Response

+/- 0,5dB 20Hz — 24KHz

Dynamic Range

105dB (ADC)
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Line Inputs

Input Impedance 44 KOhm
Full Scale Level at Maximum Gain -b,5dBu
Maximum Input Level +16dBu
SNR (weighted) >100dB
THD+N 0,009%

Frequency Response

+/- 0,5dB 20Hz — 36KHz

Dynamic Range

105 dB (ADC)

Audio Outputs (D/A)

Channels 2

Sample Rate 44.1, 48, 88.2, 96, 192 kHz
Bit Resolution 16, 24 Bit

Converter Cirrus Logic
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Line Outputs

Output Impedance 100 Ohm
Maximum Output Level +6,3dBu
SNR (weighted) >100dB
THD+N 0,010%

Frequency Response

+/- 0,5dB 22Hz — 44KHz

High/low level switch

Full scale 5Vpp / -14dB

Headphone Output

Load Impedance

8-600 Ohm

Maximum Output Level

1,61V rms @ 100 Ohm

SNR (weighted)

>91dB

THD+N (60 Ohms)

0,013%

Frequency Response

+/- OmbdB 22Hz — 44KHz
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8.3 Power Supply

USB 2.0 interface, 5V/ 500mA bus power

No additional power supply or battery is needed, only power from the USB is required.
However, proper operation is guaranteed only when RIG KONTROL is used as a single
device with a USB 2 controller, or with a self-powered USB 2 hub.

8.4 Dimensions and Weight

Dimensions: 360 x 237 x 102 mm (14.1 x 9.3 x 4 inches)
Weight: 2.6 kg (5.7 Ibs)

8.9 Environmental Specifications:

Operating temperature: 0°C to 40°C (32°F to 104°F) (85% non-condensing humidity)
Storage temperature: -20°C to 50°C (-4°F to 122°F) (85% non-condensing humidity)

8.6 System Requirements

8.6.1 General System Specifications

Mac OS 10.4.x, G4 1.4 GHz or Intel® Core™ Duo 1.66 GHz, 1024 MB RAM,
USB 2.0

Windows XP with Service Pack 2 or Windows Vista (32 bit),

Pentium/Athlon XP 1.4 GHz, 512 MB RAM, USB 2.0
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8.6.2 Supported Driver Formats
Mac OS: Core Audio™
Windows: ASIO® (recommended), DirectSound™

8.6.3 Supported Platforms

Mac OS: Stand-alone, VST®, Audio Units™, RTAS® (Pro Tools 7/8)
Windows: Stand-alone, VST®, RTAS® (Pro Tools 7/8)
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